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1. How to install the Gallery Plugin from your dashboard.

1. Log in to your site as an administrator.

« -} [D promo.bestwebsoft.com/wp-l0gin.php

@WORDPRESS

You are now logged out.

Username
root k|
Password

B k|

@) Remember Ve

Lost vour password?

- Backto promo.bestwebsoft.com

2. Go to your Dashboard and find the menu on your left.

Screen Options v | | Help

—— Dashboard
Home

Updates
Dismiss

5> Posts Welcome to WordPress!

) Media We've assembled some links to get you started

] Pages Get Started Next Steps More Actions

© comments

# Write your frst blog post [E)  Manage widgets or menus
Customize Your Site -
Appearance B rrewmries ®  Tum comments on or off

% Plugins N
o or, change your theme completely &) View your site & Leam more about getting started

23 users
T} Tools
Settings Right Now QuickPress
9 BWS Plugins Content Discussion
1 post 1 comment
Add Media
DR p— L]
1 category 0 Pending
0 Tags 0 spam -
Theme Central with 6 Widgets
You are using WordPress 3.7.1. Save Draft | | Reset bl
Recent Comments Recent Drafts
From Mr WordPress on Hello world! # There are no drafs at he moment

Hi, thisis a comment. To delete a comment, ustlog in and view the posts comments. There you will have

‘WordPress Blog

Al | Pending (0) | Approved | Spam (0) | Trash (0)

‘WordPress 3.8 Beta 1 November 21, 2013

The firstbeta of the 3.8 is now available, and the next dates to watch out for are code freeze on December 5th and a inal release on December 12th. 38
el of the I \d while this isn't our first fodeo, expect this o be more beta than usual[..]

Incoming Links

20,2013

‘WordPress 3.7.1 Maintenance Release Ociob
WordPress 3.7.1 is now available! This mainenance release addresses 11 bugs in WordPress 3.7, including: Images with captions no longer appear
broken n the visual editor. Allow p to check for updates from WordPress.org. Avoid fatal

ertors with certain plugins that were incorrectly calling som[...]

e Blog Search so thatwhen another blog lnks to your site itwillshow up here. thas found no incorming fnks..
Jet.Its okay — there s no rush

Plugins

Othor WardPrass Nows
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3. Select “Plugins” => “Add new".

Yo =
7

Screen Optons v | Help
Home
Updates
Dismiss
P Posts Welcome to WordPress!
) Media We've assembled some links to get you started
) Pages Get Started Next Steps More Actions
© Comments
s Wiite your first biog post [E]  Manage widgets or menus
Customize Your Site ,
Appearance & Addan About page ®  Tum comments on or off
& Plugins Installed Plugins .
leme completety ] View your site & Leam more about getting started
AddNew |
& users
g
T} Tools
Sett
ings Right Now QuickPress 3
O BWS Plugins Content Discussion
1 post 1 comment
g Ada Media
2 pages 1 Approved
1 category 0 pending
0 Tags 0 spam 4
‘Theme Central with 6 Widgets
‘You are using WordPress 3.7.1. Save Draft | | Reset Publish
Recent Comments e ———
From Mr WordPress on Hello worldi # e are 1o crafis atthe moment
Hi, this s a comment To delete a comment,just log in and view the posts comments. There you willhave ...
‘WordPress Blog =
All | Pending (0) | Approved | Spam (0) | Trash (0
WordPress 3.8 Beta 1 November 21, 2013
“The first beta ofthe 3.8 is now avallable, and the next dates to watch out or are code freeze on December 5th and a final release on December 12ih. 3.8
e L eral ofthe ! d while thisIsn'tour istrodeo, expect this to be more beta than usual. |
le Blog Search so that when anofher blog links to your sit itwill show up here. Ithas found no incoming links. W A e s G TS A
yet Its okay — there is o rush WordPress 3.7.1 is now availablel This maintenance release addresses 11 bugs in WordPress 3.7, including: Images with captions no longer appear
broken in the visual editor. Allow it on old or poorly 0 check for updates from WordPress.org. Avoid fatal
errors with certain plugins that were incorrecty calling som [..]
e Othor WardPross News =

-admin/plugirv-install.php =

Screen Options v | | Help

(t Dashboard
&@ Install Plugins
2 Posts
Search | Upload | Featred | Popuar | Newes | Favortes
Media
e and expand ne y ofWordress. You may y nstall plugins fom the WordPress Plugin iecory or upload  pluginn 2p format i s page
© Comments —
Appearance Search Plugins
& Plugins
Popar ags

Installed Plugins
You may also browse based on the most popular tags i the Plugin Directory:

‘Add New
Edior . .
admin AAX buddypress cstecory commen COMMENS content email Facebook ted gallery google image images javascrpt jauery

Users. . . .

= ink kS oan media PAQE pages proto prows PIUQIN POSE POStS rss seo shortcode sidebar social s sws twitter viseo
Tools. h

ﬂ Widget wiiges worgpress sanse

[57] Settings

3 BWS Plugins

Thank you for creating with WordPress. Version 3.7.1

Official website: http://bestwebsoft.com/ Page 4 of 36
Support forum: http://support.bestwebsoft.com/



http://www.google.com/url?q=http%3A%2F%2Fbestwebsoft.com%2F&sa=D&sntz=1&usg=AFQjCNGJOfx7bDP0OPM8LDcwJckBA41ZdA
http://www.google.com/url?q=http%3A%2F%2Fbestwebsoft.com%2F&sa=D&sntz=1&usg=AFQjCNGJOfx7bDP0OPM8LDcwJckBA41ZdA
http://www.google.com/url?q=http%3A%2F%2Fsupport.bestwebsoft.com%2F&sa=D&sntz=1&usg=AFQjCNE1jFIjvYM0fk-cMNeDusUYVToCig
http://www.google.com/url?q=http%3A%2F%2Fsupport.bestwebsoft.com%2F&sa=D&sntz=1&usg=AFQjCNE1jFIjvYM0fk-cMNeDusUYVToCig

Gallery Plugin

Installation Instruction

5. Type “Gallery” there and click “Search Plugins”.

S Q0 & =

(1 Dashboard R Screen Options v | Help
&% Install Plugins
 Posts
Search | Upload | Featured | Popular | Newest | Favorites.
(5 Media
0 Pages and expand the t of WordPress. You may i insallplugins rom the WordPress Plugin Direciory or upload a plugin in zip format via fis page.
© Comments P /
[EJ Appearance | Gallent x || Search Plugins
Installed Plugins. Popular tags
Add New Youmay aiso browse based on the most popular tags in the Plugin Direciory:
Editor . ) )
a admin Aax pusypress ceisoory commens COMMENIS conten: email Facebook teea gallery google image images javaserpt jauery
Users. - -
iink linkS ban meda PAge pages pnoio phowos PIUGIN POSt POSES 1ss seo shortcode sidebar social sn siws WWItter vigeo
T} Tools
widget wies wordpress souse
Setiings

3 BWS Plugins

Thank you for creating with WordPress. Version 3.7.1

6. You will see a list of plugins.

earch+Plugins

e Scroen Optors v | Help
% Install Plugins
5 Posts
Search | Search Resuts | Upload | Feaurd | Popuar | Newes | Favores
gy Media
0 ages Keyword v| AR x | Search Pugns 115 tems 1 jota0 s/ (a
© Comments Name Version Rating Description
P Gatery 409 ey i lugin malkest posice f Implement as many gallres a you want o your webste. Youcan add maltpe icures and descrpon fr eachgalry, show hem al atone page, view
e each one separately. Moreover, you can upload HQ images. Regular updates and simpliciy of usage along with eficient nctionality make it a perfect choice for your ste o have an
& Plugins appealing look.
There s s By Bestwebsot
nsalled P
installed Plugins Gallery Bank 2020 77 Gallery Bankis the bestWordPress plugin that allows you to create pl an ease in your
AddNew ot e i Ithas e abilty i upoad Images, i opions ke adting, eciin,fo-ordersoring and delting mages n the Al
caor Gallery Bank s desged 1o adapt each ool i any Siaon & an be ealy used on moBles & 1152 Responsve Plugin
December2, 2013: W... By Gallery-Bank. r
8 users entoen catery 2o T oo catey P
e [ NoxGEN Gallery e st popular WordPress galry plugin, and one of e mostpopular WiordPress plginsof al e, it over 7.5
Korovidesap ot uploacing and Images,with the aliy 1o batch uptoad, mper met data, addideeiearange/sors mages, edi humbras, group
setings ghlles o albums,and more. . By Phoacrat Medis
Social Gallery Lite 222 b4 V” The Ultimate Social Lightbox Plugin for WordPress
3 BWS Pugins S Thats ight you can now gt a L1 version o e bt seling Socal Galleryfor Fre!
I ol il a6 featutepacked a5 Saral Galley o 6t 5 5l Kk a5y re Iooking o festout Socil Gallery r your o a ma o e1c) budgt you can et a copy here,ustclk e
o fed Downiond Version 5.1 utan ab. . By epepiUgnS
ReFiex Gallery 22 777 ReFlex Galleryis a fully responsive WordPress image gallery plugin thatis actually wo galleries in one. ReFlex Gallery uses a FlexSider style galery or all mobile devices with a screen
et e i Wi of 430 pcts ot ks and Gynamically croate pretyPhats 1o Galeie for i sroen widhs above 430 pets. ReFiox Gallery allows of mltfe galres ot page
Vo
Featres inclue
Respons... By Hahn Creative Group
WP -Commerce Dynaic Gatlery 1101 e s so0n as you nstall P ¢ Commerce brings yoursore o e wiha staing e
Detas sl Now Key Feares
Incanty 2  scroling gallry o everyproduct page
Automatically shows overy mage n each product galley hat has been uploaded o the ot (roduc)
seauitly n Frlos,Sa. By A3 Reveluton
ommerce Dynamic F03Y Assoon asyouinsal brings your sore o e wiha st e e e
WooC: Dynamic Gallery 1254 YTy A ¥ 11 WooC - Jite with Jiding 1y product pag
Details | Install Now Key Features
e #1 Proguctage image galleryfor WooCommerce Products page
e seauttaly n Fiees, Safr, Chrome and Opera on Appe O X and on Widows XP to Windows 8 n €7 0 10
Fllmobie d.. By A5 Revoluton
NextGEN Gallery Optimizer 112 %7 77 77 7Y NextGEN Gallery Optimizer
Dot e o Imroves your ste's page ead speed by ensuing Nex{GEN Galery' scrts and ses ONLY load on posis wit e nggallery = shorcade.
a0 nclodes and e aniaste e XD 2 Spesdy el Requies NexGEN Galery 162 and up
Plasaote: T basicverson crtentyany. . By iark 3
WP Easy Gatlery s WP Easy Gallry s an eas o use WordPress gl luginhatallowsyou  create and manage mltpl image galleies rough asimle acmin nerface

Features include
Enhanced social sharing capabilites for images

Newly added class name (wp-easy-gallery) for easy thumbnail syling
Upload unique thumbnailimage for galleries and set custom dimensions
Include lpo... By Hah

Details | Install Now

Awesome Fiickr Gallery 334 ¥ Awesome Fiickr Gallery is a simple, fast and light plugin to create a
Deals | Install Now gallery of your Fiickr photos on your WordPress enabled website. This plugin
. aims at providing a simple yet customizable way to create clean and professional looking Fiickr
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7. Find the necessary plugin in the list. Please read the description carefully to be sure you
select the right plugin.

has=Gallery

earch+Plugins 5| @ O

4} Dashboard ) Screen Optons | | Help
% Install Plugins
s Posts
Search | SearchResults | Upload | Featured | Popular | Newest | Favorites
) Media
0 Pages Keyword v (S5 x | searcn Plugins 1,195 ttems 10140 >
© Comments Name Version Rating, Description
Appearance 409 [This plugin makes t possible o implementas many galleries a5 you want into your website. You can add muliple pictures and descripton for each gallery, show them all atone page, view.
eI insall Now each one separately. Moreover, you can upioad HQ images. Regular updates and simpliciy of usage along with efficient funcionality make it  perfect cheice for your st o have an
& Plugins appeaiing look
[Tere is aiso... By Bestwensot
nstalled P
netaled Flugine Gallery Bank 2020 Y7 Gallery Bankis the best WordPress plugin that allows you o create p an ease in
AddNew Details | Install Now Ithas the ability to upload images, with options like adding, editing, re-orderisorting and deleting \mages in the Album.
Edior Gallery Bark i designed to adapt each portiolio to any situation and can be easily used on mobiles as tis a Responsive Plugin.
December2, 2013: ... By Galery-Bank [
& Ysers NextGEN Gallery 2040 Y7 WordPress Gallery Plugin
1 Toois Detais | insall Now NextGEN Gallry it most popula WordPress galry g, oneof e most popuar Worress all time, with over 7.5
tprovides a for uploading a e, e ity 0 o, por gt il oaanGSsoages, st bumbnas, 1o
& Ghlenes i aimane, e ot . By Pheecrs Mo
Social Gallery Lite 222 Y7 The Uimate Social Lightoox Plugin for WordPress
2 BWS Plugins o Thats right - you can now get  Lit version o the best-seling Social Gallery for Free!
1t not quite as feature packed as Social Gallery Pro butits il kick a5s. Ifyou are looking o testout Social Gallery or your on  small (o o) budget you can geta copy here, just lick the
e me ed Download Version 2.2.1" bution ab... By epicplugins.
ReFiex Gallery 22 777777  ReFlexGalleryis a fully responsive WordPress image gailery plugin that i actually two galleries in one. ReFlex Gallery uses a FlexSiider syle galleryfor all mobile devices with a screen
Detais | install Now Width of 480 pixels or less and dynamically creates prefyPhoto style galleries for all screen widths above 430 pixels. ReFlex Gallery allows for muliple galleries per page.
Mo
Features include:
Respons... By HannCreativeGroup.
WP e-Commerce Dynamic Gallery 1191 # H K 7 As s00n as you nstall WP e-Commerce brings your store 0 Ife with a siing product page
Details | Install Now poyFeatns]
Instanty adas a scroling gallery to every product page.
Automatically shows every image in each productgalley that has been uploaded tothe post (product)
Gallery beautully in Firefox, Sa... By A3 Revolution
WooCommerce Dynamic Gallery 1254 XYy Assoon as you install WooC brings your store o Ife with a siing every product page
Details | Install Now ey Eeakiree)
Loe i 0. o b oo Comece o g
lery fully in Firefox, Safari, Chrome and Opera on Apple O X and on Widows XP to Windows 8n IE7 to IE10,
Pt de. By 5 Revauton
NextGEN Gallery Optimizer 112 e ¥ NextGEN Gallery Optimizer
Detais | install Now mprove your s page o spee by ensung NeXGEN Gallry' st 3 sy ONLY loa n post i n rggalery i~ horcae
Italso includes e fantastc F 50 now you can aspeedy sitel "R NextGEN Gallery 1.6.2 and up.
Pease noe-Thebasicversion cutentyony.. By Mk 1ol
WP Easy Gallery 35 ¥y WP Easy Galleryis an easy o use WordPress gallery plugin that allows you to reate and manage multple image galleries trough a simple admin interface.
Details | nstall Now. aakees Bl
Enhanced social sharing capabilites forimages
Newly added class name (wp-easy-gallery) for easy thumbnail styling
Upload unique thumbnailimage for galleries and set custom dimensions
Include HahnCreativeG
Awesome Flickr Gallery 334 # H K 7 Awesome Fickr Gallery is 2 smple, fast and light plugin to create a
Detaits | Insiall Now gallery of your Ficks photos on your WordPress enabled website. This plugin
aims at providing a simple yet customizable way to create clean and professional looking Flickr

8. (lick “Install now"

earch+Plugins | O =

¢} Dashboard Screen Options v || Help
% Install Plugins

5 Posts
Search | SearehResus | Upoad | Featured | Popuar | Newes: | Favores

gy Media

[ Pages Keyword v SR x | Search Plugins 1,195 items 1 of40 > »

© Comments Name Version Rating Description

— Gatery 400 s plugin makes I posll 0 Inplementasmany galleres a you want 1o your webste. You can dd e pctures and descton for each gallry, show rem al atne page, view

each one separately. Moreover, you can upload HQ images. Regular updates and simplicity of usage along with eficient functionality make it a perfect choice for your site 1o have an
appealing look.
There s also... By BestWebSoft

Details
& Plugins

Installed Plugins

Gallery Bank 2020 ¥ Gallery Bankis the best WordPress plugin that allows you o create p an ease in your
AddNew Detae | ntal Now Ithas the abilty o upload images, it optons ke adding, ecting,re-ordersorting and deleting mages i the Album
Edior Gallery Bank s designed to adapt each portolo fo any situation and can be easily used on mobiles as t s a Responsive Plugin.
December 2, 2013:W... By Galery-Bank. [
& Users NextGEN Gallery. 2040 WordPress Gallery Plugin
T} Toots T NesGEN Gallry s th mostpopular WordPres gallry pluin andoneofhe st poulr Worres all time, with over 7.5
Itprovides a for uploading a TV i e e e e eV SN e e TR R
Setiings galleries into albums, and more.... By pricheitrr
Social Gallery Lite 222 ¥ The Ulimate Social Lightbox Plugin or WordPress
3 BWS Plugins e Thats right—you can now get a Lite version ofhe best seling Social Gallery fo Free!
1ts not quite as feature packed as Social Gallery Pro butis il kick ass. I you are looking to festout Social Gallery or your on 2 small(or zero) budget you can get a copy here, just lick the
. red Download Version 2.2.1" bution ab... By epicplugins.
ReFiex Gallery 22 7777 ReFlex Galleryis a fly responsive WordPress image gallery plugin thatis aciually wo galleies in one. ReFlex Gallery uses a FlexSiider siyle gallery for all mobile devices with a screen
! width of 480 pixels or less and dynamically creates preflyPhoto siyle galleris for all screen widihs above 480 pixels. ReFlex Galery allows for muliple galleries per page.
MO
Fealures include:
Respons... By HannCreativeGroup.
WP e-Commerce Dynamic Gallery 1191 e A K 7 As soon as you nsiall WP e-Commerce brings your siore (o lfe with a siiding prodiuct page
Details | Install Now Key Features
Instanty adds a scroling gallry t0 every product page.
Automatically shows every image in each produci gallery that has been uploaded fo he post (produc).
Gallery beauiully in Firefox, Sa... By A3 Revolution
WooCommerce Dynamic Gallery 1254 ¥7¢7  Assoon asyouinstall WooCommerce Dy brings your store to e with a siing I 1y product pag
Detais | Install Now Key Features
i ol e e, oot s o
lly in Firefox, Safari, Chrome and Opera on Apple OS X and on Widows XP to Windows 8 in IE7 t E10.
Full mobile de EyAZREVn\uunn
NextGEN Gallery Optimizer 112 NextGEN Gallery Optimizer
T mproves your s pagead spesd by ensug NexGEN Gallery’s st and s LYl on poss i e Iggaley - shrode
Italso includes and e faniasic F S0 now you can a speedy sitel "R NextGEN Gallery 1.6.2 and up.
Please note: The basic version curtentlyonly... By Mark Jeld
WP Easy Gallery 35 WP Easy Gallery is an easy to use WordPress gallery plugin that allows you to create and manage multple image galleries trough a simple admin interface.

Features include:
Enhanced social sharing capabilites for images.

Newly added class name (wp-easy-gallery) for easy thumbnail stying
Upload unique tumbnl image for gallres and set ustom dimersions

Details | Install Now

Include multp apageipo
Awesome Flickr Gallery 334 7 #7777 Awesome Flickr Galleryis a simple, fastand light plugin to create
Details | Instal Now gallery of your Flickr photos on your WordPress enabled website. This plugin

i
aims at providing a simple yet customizable way to create clean and professional looking Fiickr
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9. A popup window will ask you to confirm your wish to install the Plugin. Click “OK"

earch+Plugins

4 Dashboard Screen Options v | | Help
% Install Plugins

# Posts
Search | SearchResults | Upload | Featured | Popular | Newest | Favorites

gy Media

T Keyword v Gallry w [ search Piugins fr—- 1 ota s s

© Comments Name Version Rating Description

Appearance Gallery 409 “This plugin makes it possible to implement as many galleries as you wantinto your website. You can add multple pictures and description for each gallery, show them all at one page, view

each one separately. Moreover, you can upload HQ images. Regular updates and simplicity of usage along with eficient functionality make it a perfect choice for your site 1o have an

Details | Install Now e
& Plugins appealing loo}
There s also... By BestWebSoft

Installed Plugins

Gallery Bank 2020 Galery Bankis the best WordPress plugin that allows you o create p an ease in your
Add New BT Ithas he abilfty o upload images, with optons ke adding, editing, re-orderiorting and deleting images in the Album
edior Gallery Bankis designed 0 adapt each portolo to any situation and can be easily used on mobiles as s a Responsive Plugin
December 2, 2013: W... By Gallery-Bank. I
A NextGEN Gallery 2040 WordPress Gallery Plugin
T} Toois Detas | nsal Now NextGEN Gallery s the most popuar WordPress gallry plugin, and one of the most popular WordPress piugins of al ime, it over 7.5
Itprovides a p for uploading and images, with the abilty o baich upload, import meta data, add/deletelrearrange/sort images, dit thumbnals, group
Settings -
Social Gallery Lite 222
1 BWS Plugins Details [ Install Now Are you sure you want to install this plugin? _f-selling Social Gallery for Free!
i il ick ass. fyou are looking o est out Social Gallery or your on a small(or zero) budget you can get a copy here, justclck the
o= fins.
ReFlex Gallery 22 gallery plugin hats actually wo galleries in one. ReFlex Gallery uses a FiexSiider syle galleryfor all mobile devices with a screen

Details | Install Now PityPhoto style galleries for all screen widths above 480 pixels. ReFlex Gallery allows for multiple galleries per page.

Respons... By Hahn CreativeGroup.

WP e-Commerce Dynamic Gallery 1191

A 500n as you install WP e-Commerce brings your store o lfe with 2 siding product page
Key Features
Instanty adds a scrolling gallery to every product page.
Automatically shows every image in each product gallery that has been uploaded to the post (product).
beautiullyin Firefox, Sa... By A3 Revolution

Details | Install Now

% 77 7%  Assoon asyou install WooC( brings your store to lfe with a siiding every product page.
Key Features

WooCommerce Dynamic Gallery 1254
Details | Install Now

‘The #1 Product Page image gallery for WooCommerce Products page.
0 fully in Firefox, Safari, Chrome and Opera.on Apple OS X and on Widows XP to Windows 8 n [E7 to IE10.

Gallery
Full mobile de... By A3 Revolution.

NextGEN Gallery Optimizer 112
Details | Install Now

NextGEN Gallery Optimizer
Improves your sit's page load speed by ensuring NexiGEN Gallery's scripts and styles ONLY load on posts with the [nggallery id=x] shortcode.

talso includes an e fantastc S0 now you can ND a speedy site! "R NextGEN Gallery 1.6.2 and up.
Please note: The basic version currently only... By Mark Jeld

WP Easy Gallery 35
Details | Install Now

%7777 WP Easy Galleryis an easyto use WordPress gallery plugin that allows you o create and manage multiple image galleries through a simple admin interface.
Features include

Enhanced social sharing capabilites for images

Newly added class name (wp-easy-gallery) for easy thumbnail syling

Upload unique thumbnailimage for galleries and set custom dimensions,

Include multp apage/po... By HahnCreati

Awesome Flickr Gallery 334
Details | Install Now

Awesome Fiickr Gallery is a simple, fast and light plugin to create a
gallery of your Flickr photos on your WordPress enabled website. This plugin
aims at providing a simple yet customizable way {0 create clean and professional looking Flickr ~

10.The resulting installation screen will list the installation as successful or note any problems
during the install.

€ 2 [0 pom php7actior

y-pluging

{3} Dashboard . .
@ Installing Plugin: Gallery 4.0.9
5 Posts
Downloading install package from https : //downloads .wordpress.org/plugin/gallery-plugin.4.6.9.zip.
Media
E Unpacking the package.
Pages
0 Pag Installing the plugin.
© Comments
Successtuly insaled e plugin Gallry 4.0.9
Appearance Activate Plugin | Return to Plugin Installer

& Plugins

Installed Plugins
Add New
Editor

& Users
T} Tools
Settings
g

3 BWS Plugins

Thank you for creating with WordPress. Version 3.7.1

Official website: http://bestwebsoft.com/ Page 7 of 36
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Gallery Plugin

Installation Instruction

11.Click “Activate Plugin”.

(3} Dashboard . L
&\@ Installing Plugin: Gallery 4.0.9
5 Posts
Downloading install package from https ://downloads .wordpress.org/plugin/gal lery-plugin.4.0.9.zip.
Media
= Unpacking the package.
[0 Pages

Installing the plugin.

@ Comments
Successiully nstalled the plugin Gallery 40.9

Appearance Activate Plugin]| Return to Plugin Installer

& Plugins

Installed Plugins
Add New
Editor

& users
T4 Tools
Settings

39 BWS Plugins

Thank you for creating with WordPress.

Version 3.7.1

12.Voila - Gallery is activated! It will appear in the list of Installed Plugins.

() Dashboard

(% Plugins s nen
s Posts.

3 Media Plugin activated.

[ Pages
Al () | Active (2) | Inactive (2
© Comments
Bulk Actions v | Apply
Galleries
[ Plugin Description
Appearance
[ Akismet Used by millions, Akismetis quite possibly the bestway in the world to protect your blog pam. itkeep ¥
& Activate | Edit| Delete APl key, and 3) Go o your Akismet configuration page, and save your AP key.
Installed Plugins Version 2.5.9 | By Automatic | Visit plugin site
Add New
() ContactForm Plugin for Contact Form.
Edior Settings | Deactivate | Edit
& S Version 3,66 | By BestWebSoft| Visitplugin sie | Settings | FAQ | Support
Users
) Galery [This piugin allows you to iImplement gallery page into web st.
Tools
il Setings| Deactvate | EGl frcjon 4.0.0| By BestiebSot| Visitplugin ste | Setings | FAQ Support
Settings
[ HelloDolly This s notjusta plugin hope . up in two words sung by L
) BWS Plugins GRS Version 1.6 | By Matt Mullenweg | Visit plugin site

[ Plugin Description

BulkActions v | Apply

Thank you for creating with WordPress.

Official website: http://bestwebsoft.com/
Support forum: http://support.bestwebsoft.com/

Screen Options v | Help

Search Installed Plugins

sleep. To get started: 1) Click the "Actvate" link to the leftof this description, 2) Sign up for an Akismet

you will randomly see a lyric from Hello, Dolly i the upper right of your admin screen on every page.

Version 3.7.1
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Gallery Plugin

Installation Instruction

2. How to install the Gallery Plugin from the developers’
site manually

1. Go to http://bestwebsoft.com/plugin/gallery-plugin/#download and click “Download from
SVN”"

Gallery plugin | BestWe x

@ About  Services  Portfolio
7

Tips Quotes from our clients

We are sure that.you have already vievied.a lot of plugins, but still et "Sergey did an excellent job completing the work. I would be more than
us draw your attention to ours. happy o give him my next job."

Products | Testimonials  Contacts

Elias Nathaniel | Vandema Investments Inc.

WP Plugins | Gallery plugin Maketaldonation
Donations play an important role in
supporing open-source projcts. We
GALLERY gratly appreciate any donation you can
make to help s support further
development o res products!

DONATE

http//bestwebsoft.com/
httpy/support bestwebsoft.com/

Technologies

NeT ss0gs 960QS AddThis plugin
Dounioad ftom Wordiress xmnse AdObe Mllustrator

Download from Google Code Adobe InDesign Adobe

Photoshop AJAX a n o
SEO Pack amCharts aMember AVFoundation AVG
Aweber AP BackSiretch Query pugin Banners
Basecamp bbpress Bheimp Ereadcrumb NavXT
BuddyPress Cr+ Chagly APl Cocoa
Codelgniter comments Box Contact Form

7 carscraones CSS ess 2 css 3

CSS3 CURL Datepicker Disqus Dr. Web
Drupal Drupal 6 Ecommerce Facebook AP
FaceBook Open Graph API Fadesideshow Plughn
Fancybox  Fabtastc FedEx APl Feed
FiverScript Flash Foundaton Fulcalendar script
GO fbrary GeolP GetResponse GelResponse API
GIT Google+ API Google Analyics Google
Charts Google Map APl Google
ReCaptcha API Googie visuaization Geochart API

Graphic design e roms
Sinisa sai - HTML HTML5 imuge weget

Instagram APl 10S  gestures 1S SDK

produced by BESTWEBSOFT

There are 603 comments:

AT

2. You will see the list of plugin’s versions

VS saieny g et ) 65 s i connic=s e
2 bus pulic dowoadp pgisigaleys _________________________________—_———————————— aa0@ =

bws_public_download - Revision 130: /wp_plugins/gallery

e e e s s s s s s s s e s s s e e s e

Powered by Apache Subversion version 1.7.6 (r1370777).
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Gallery Plugin

Installation Instruction

3. Select the one you need or the latest one:

PSR © v
-] [ despace:

- public_ o I / 75| @ O

bws_public_download - ision 130: /wp_] ins/gallery

Powered by Apache Subversion version 1.7.6 (r1370777).

4. A popup window will suggest the place to save. Select Desktop and click “Save":

) Gallery plugin | Bestwe x,/ [ bws_public_download - x \_|

BEE|
-} [ despace: . public_ wp_ I / i?]q,@ =
bws_public_d load - ision 130: /wp_] ins/gallery
® .
« gallery-plugin.3.8.6.zi
allery-pl

[l
Name: [oallery-plugin.2.0. 9k ]
Save in folder: (EZDesktop

> Browse for other folders

Places Name v size Modified|[-]
@4 search

® Recently Used

5 lag

&/ Desktop

[ File System

« gallery-plugin.4.0.9.zif

Powered by Apache Subversion version 1.7.6 (r1370777).

(e ] [comoe)
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Gallery Plugin

Installation Instruction

5. Make sure that the zip-file has appeared on your desktop.

6. Extract the Plugin folder to your desktop.

Official website: http://bestwebsoft.com/ Page 11 of 36
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Gallery Plugin

Installation Instruction

7. Read through the "readme" file thoroughly to insure you follow the installation
instructions.

Gallery plugink
File Edit View Go Bookmarks Help
gallery-plugin

Foward v 4 @ & L Icon View

bws_menu fancybox

languages template

upload gallery-plugin.php readme.txt screenshot-Ljpg

- =T 1]
S
= =

screenshot-2.jpg screenshot-3.jpg screenshot-4.,jpg screenshot-5.jpg

16 items, Free space: 291.1 GB

File Edit View Search Tools Documents Help

[ BJopen v @save (% undo > o F
readme.txt X

= Installation ==

1. Upload the “Gallery’ folder to the directory '/wp-content/plugins/" .
b. Activate the plugin using the 'Plugins’ menu in WordPress.
Please check if you have the template file "gallery-template.php' as well as the template 'gallery-single-template.php' i

- .php* in the templates directory. If you can't find these files, then just copy them from the directory /wp-content/
lugins/gallery/tenplate/* to your templates directory.

== Frequently Asked Questions ==
= I cannot view my Gallery page =
1. First of all, you should create your first Gallery page and select 'Gallery' in the list of available templates (it will be used for displaying the Gallery).

2. If you cannot find ‘Gallery’ in the list of available templates, then just copy it from the directory /wp-content/plugins/gallery-plugin/template/’ to your templates directory
= How to use the plugin? =

1. Click 'Add New' in the ‘Galleries’ menu and fill out your page.

2. Upload pictures via the uploader at the bottom of the page.
3. Save the page.

= How to add an image? =

- Choose the necessary gallery in the Llist on the Galleries page in the admin section (or create a new gallery by clicking 'Add New' in the *Galleries' menu)
- Use the option 'Upload a file' in the uploader, choose the necessary pictures and click 'Open’

- The files uploading process will start.

- once all pictures are uploaded, please save the page

- If you see the message ‘Please enable Javascript to use the file uploader’, you should enable Javascript in your browser.

= How to add many images? =

Multiple files upload is supported by all modern browsers except Internet Explorer.

I'm getting the following error: "Fatal error: Call to undefined function get post thumbnail id()". what should I do?

This error means that your theme doesn't support thumbnail option, in order to add this option please find the file *functions.php’ in your theme and add the following strings to this file
“add action( ‘after setup theme', ‘theme setup'

function theme_setup() {
add_theme support( 'post-thunbnails' )
After that your theme will support thumbnail option and the error will disappear.
= How to change inage order on the single gallery page? =
1. Please open the menu "Galleries” and choose random gallery from the list. It will take you to the gallery editing page.
st

Please use the drag and drop function to change the order of the images and do not forget to save the p
Please do not forget to select 'Sort images by’ -> ‘sort images'

in the plugin settings (http: //yuurﬁdumam/wp adnin/adnin. php?page=gallery-plugin.php)

Official website: http://bestwebsoft.com/
Support forum: http://support.bestwebsoft.com/
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Gallery Plugin

Installation Instruction

8. With your FTP program upload the Gallery folder to the /wp-content/plugins/ folder in

your Wordpress directory online.

Blugins’

File Edit View Go Bookmarks Help
ovard v 4 Q Q| @B M

10 [ o o

4 Back v

Placesv

akismet

.

index.php

contact-form-plugin

gallery-plugin

hello.php

5 items, Free space: 291.1 GB

9. Find the plugins menu on your left and click “Installed plugins”:

(& Dashboard .
(@ Plugins  Aganew
& Posts
Mea
Gy Media Contact Form to DB allows to store your messages to the database.
Pages

Manag ges that hav

sentfrom your website
© Comments

Screen Options v | | Help

LEARN MORE

Appearance The selected plugins have been deleted.
& Plugins

All(3) | Active (1) | Inactive (2) Search insialied Bluging|
nstalled Plugins
AddNew BuikActons v | Apply 3 tems
Edior

[ Plugin Description
& Users

O Akismet Used by millions, Akismet is quite possibly the best way i fhe worid to protect your blog Itkeeps your ste protecied from sp You sleep. To get stared: 1) Click he "Activate” ink o th lefoftis descripton, 2) Sign up for an Akismet
T} Tools Actvate | Edt[Delele APl key, and 3) Go o your Akismetconfiguraton page, and save your APl key.
Setiings Version 259 | By Automatic | Vit plugin site
2 BWS Plugins (] ContactForm Plugin for Contact Form

Setings | Deaciivate | Edit
. etiings | Deactivate | Edt .. 1o 3,66 | By BestwebSot | Visit plugin sit | Settings | FAQ | Support
Collapse menu
[ HelloDolly This is notjust a plugin, op 4 up in o words sung byLe Hello, Doly. Wh Youwill randomiy see a yric fom Hello, Dallyin e upper ight of your admin screen on every page.
Actvate | Edit] Delet
| Edt| D) Version 1.6 | By Matt Mullenweg | Visit plugin site
[ Plugin Description
Bulk Actons v | Apply 3 tems
Thank you for creating with WordPress. Version37.1

Official website: http://bestwebsoft.com/
Support forum: http://support.bestwebsoft.com/
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Gallery Plugin

Installation Instruction

10. You will see a list of installed plugins:

@ & [ [ promo.bestwebsoft.com 2|0 =

& Dashboard . Screen Options v/ | Help
@ Plugins  Adanew

5 Posts

(5 Media

[ Pages . LEARN MORE

© Comments

Appearance All(4) | Active (1) | Inactive (3) | Recently Active (1) Search nsialied Blugins,

& Plugins BulkActions v | Apply 4items

Instalied Plugins
(1 Plugin Description

Add New L] = -

Edior O Akisme Used by millions, Aismet s quite possibly the bestuway in the world o protect your pam. It keeps your site pofecied flom spam even while you sieep. To getsiarted: 1) Click the *Actvate* nk o the letof this descripton, 2) Sign up for an Akismet

Activate | Edit|Delete | APl key, and 3) Go o your Akismet configuration page, and Save your AP ky.
Users

L) Version 2.5.9 | By Automatiic | Visit plugin site

T} Tools .
() Contact Form Pluginfor Conact Form,

Settings setings | Deactivate |01 | yergion 3,66 | By BestwebSot|Vistplugin it | Setings | FAQ | Support

) BWS Plugins [=] “This plugin allows you to implement gallery page into web site.

Gallery.
Activate | Delets
n D Version 409 | By BestWeDSoft| Visit plugin site

[ HelloDolly ‘This is not justa plugin, it symbolizes the hope d up in two words sung byLc trong: Hello, Dolly. Wh
Activate | Edit| Delete

you will randomly see a lyrc from Hello, Dolly in the upper right of your admin screen on every page.
Version 1.6 | By Matt Mullenweg | Vit plugin site

[ Plugin Description
11.Find “Gallery” and click “Activate”
@ & [ [ promo.bestwebsoft.com/wp-admin/plugins.php b q, © =
(% Plugins  awnen
5 Posts
@ Contact Form to DB allows to store your messages to the database.
[0 Pages LEARN MORE
29 Mana e jes that have been sent from your website.
© Comments
Appearance Al (4) | Active (1) | Inactive (3) | Recently Active (1) Search Installed Plugins
& Plugins BulkActions v | Apply Siems
(] Plugin Description
Add New L] = L
] Version 2.5.9 | By Automatiic | Visit plugin site
T} Tools =
Settings Settings | Deactivate | Edit

Version 3,66 | By BestWebSoft| Visit plugin site | Setings | FAQ| Support

3 BWS Plugins s plugin allows you o implementgallry page ino web sie.

Version 40,9 | By BestWebSot| Visitplugin site

[ HelloDolly ‘This is not justa plugin, it symbolizes the hope d up in two words sung byLc trong: Hello, Dolly. Wh you will randomly see a lyrc from Hello, Dolly in the upper right of your admin screen on every page.
Activate | Edit| Delete

Version 1.6 | By Matt Mullenweg | Visit plugin site

[ Plugin Description
Bulk Actions v | Apply 4items
Thank you for creating with WordPress. Version 3.1
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Gallery Plugin

Installation Instruction

12.Voila - Gallery is activated!

@« = | [ promo. php?ac

Q0@ =

Yo Screen Optors v| | Help
(gé Plugins  Aganew

5 Posts

Media
@ Contact Form to DB allows to store your messages to the database.

LEARN MORE
e ——————

© Comments
Galleries

@ Appearance

ANl | Active (2) | Inactve (2) Search nstalled Plugins.
& Plugins

BulkActions v | Apply

Installed Plugins ems
Add New ] Plugin Description
Edgitor
[ Akismet Used by millons, Akismet s quite possibly the bestway in the wrld o protect your biog from commeent and trackback spam. It keeps your sie protected flom spam even while you sleep. To get stated: 1) Click the "Activate” ink o the leftof tis descripton, 2) Sign up for an Akismet
B Users Activate | Edit| Delete API key, and 3) Go to your Akismet configuration page, and save your AP! key.
T} Tools Version 2.5.9 | By Automatic | Visit plugin site
Settings () ContactForm Plugin for Contact Form.
3 Bws Plugins setings| Deactvate | B0 yorgion 3,66 | By Bestwensot|Visitplugin st | Settings | FAQ| Support
Gallery “This plugin allows you o implement gallery page into web site.
o i A Version 4.0.9 | By BestWebSoft| Visit plugin ste | Setiings | FAQ| Support
O  Hello Dolty This is not justa plugin, hope d Up in two words sung byLe Hello, Dolly. Whe ‘you will randomly see  lyric from Hello, Dolly in the upper right of your admin screen on every page.
GRS Version 1.6 | By Matt Mullenweg | Visit plugin site
) Plugin Description
Bulk Actions v | Apply 4 ttems
Thank you for creating with WordPress. Version 3.7.1
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Gallery Plugin

3. How to install the Gallery Plugin from wordpress.org
1. Go to http://wordpress.org/plugins/gallery-plugin/ and click “Download version 4.0.9”

(always the latest one is available)

\?}‘ ‘WORDPRESS.ORG

Showcase  Themes Mobile Support Getinvolved ~About Blog Hosting

Plugin Directory

Extending WordPress
produced by BESTWEBSOFT

- Newest

« Recenty Updated
- MostPopular

« Highest Rated

- Developer Center

:“H Gallery

ldeas
Ketch!
“This plugin allows you to implement a gallery page into your website.
Search Plugins
Descrption | Installation FAQ Screenshols Changelog Stals Suppe
Search

Popular
Tags More»  This plugin makes it possible to implement as many galleries as you want into your

website. You can add multple pictures and description for each gallery, show them all at
widget (3827) one page, view each one separately. Moreover, you can upload HQ images. Regular
Post (2420) updates and simplicity of usage along with efficient functionality make it a perfect choice
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Gallery Plugin

Installation Instruction

3. Make sure that the zip-file has appeared on your desktop.

4. Extract the Plugin folder to your desktop.
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Gallery Plugin

Installation Instruction

5. Read through the "readme" file thoroughly to insure you follow the installation
instructions.

Gallery plugink
File Edit View Go Bookmarks Help
gallery-plugin

Foward v 4 @ & L Icon View

bws_menu fancybox

languages template

upload gallery-plugin.php readme.txt screenshot-Ljpg

- =T 1]
S
= =

screenshot-2.jpg screenshot-3.jpg screenshot-4.,jpg screenshot-5.jpg

16 items, Free space: 291.1 GB

File Edit View Search Tools Documents Help

[ BJopen v @save (% undo > o F
readme.txt X

= Installation ==

1. Upload the “Gallery’ folder to the directory '/wp-content/plugins/" .
b. Activate the plugin using the 'Plugins’ menu in WordPress.
Please check if you have the template file "gallery-template.php' as well as the template 'gallery-single-template.php' i

- .php* in the templates directory. If you can't find these files, then just copy them from the directory /wp-content/
lugins/gallery/tenplate/* to your templates directory.

== Frequently Asked Questions ==
= I cannot view my Gallery page =
1. First of all, you should create your first Gallery page and select 'Gallery' in the list of available templates (it will be used for displaying the Gallery).

2. If you cannot find ‘Gallery’ in the list of available templates, then just copy it from the directory /wp-content/plugins/gallery-plugin/template/’ to your templates directory
= How to use the plugin? =

1. Click 'Add New' in the ‘Galleries’ menu and fill out your page.

2. Upload pictures via the uploader at the bottom of the page.
3. Save the page.

= How to add an image? =

- Choose the necessary gallery in the Llist on the Galleries page in the admin section (or create a new gallery by clicking 'Add New' in the *Galleries' menu)
- Use the option 'Upload a file' in the uploader, choose the necessary pictures and click 'Open’

- The files uploading process will start.

- once all pictures are uploaded, please save the page

- If you see the message ‘Please enable Javascript to use the file uploader’, you should enable Javascript in your browser.

= How to add many images? =

Multiple files upload is supported by all modern browsers except Internet Explorer.

I'm getting the following error: "Fatal error: Call to undefined function get post thumbnail id()". what should I do?

This error means that your theme doesn't support thumbnail option, in order to add this option please find the file *functions.php’ in your theme and add the following strings to this file
“add action( ‘after setup theme', ‘theme setup'

function theme_setup() {
add_theme support( 'post-thunbnails' )
After that your theme will support thumbnail option and the error will disappear.
= How to change inage order on the single gallery page? =
1. Please open the menu "Galleries” and choose random gallery from the list. It will take you to the gallery editing page.
st

Please use the drag and drop function to change the order of the images and do not forget to save the p
Please do not forget to select 'Sort images by’ -> ‘sort images'

in the plugin settings (http: //yuurﬁdumam/wp adnin/adnin. php?page=gallery-plugin.php)
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Gallery Plugin

Installation Instruction

6. With your FTP program upload the Gallery folder to the /wp-content/plugins/ folder in

your Wordpress directory online.

Blugins’
file Edit View Go Bookmarks Help

@bk v Hrovad v 4 O @ |1

Placesv

10 [ o o

akismet

.

index.php

contact-form-plugin

gallery-plugin

hello.php

5 items, Free space: 291.1 GB

7. Find the plugins menu on your left and click “Installed plugins”:

Screen Options v | Help

LEARN MORE

Search Installed Plugins

3iems

¢} Dashboard R

% Plugins  adanen
5 Posts
) Media

Contact Form to DB allows to store your messages to the database.

e Ma ntfom your
© Comments
o The sl pluin ve been deeed
& Plugins

AI(3) | Active (1) | Inactive (2)
stated Pugns
e skctons + | Aopy
Eaior

] Plugin Description
& Users

O Admet Usetby milons, Akt qul possily e besteay I e ok o protect yourbog Kop yoursis proteced fomsp
T Toots Acvae |t {Delete APl key.and <) Gotoyour At contguraion pag, and save your APy
Settings Version 2.5.9 | By Automatic | Visit plugin site
3 BWS Plugins O ContactForm Plugin for Contact Form,

Setings | Deactvate | Edit . 1 3 66 | By BestwebSoft | Viit plugin sie | Settings | FAQ| Support
o etoboty i ot st plugin h PPe— oy W, oty pp—

you sleep. To get started: 1) Click the *Activate” link o the left of this description, 2) Sign up for an Akismet

Activate | Edit] Delete Version 1.6 | By Mat Mullenweg | Visit plugin site

[ Plugin Description

BulkActions v | Apply

Thank you for creating with WordPress.
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Installation Instruction

8. You will see a list of installed plugins:

4} Dashbosra . Screen Options v/ | Help
(% Plugins  awnen
£ Posts
Media
= Contact Form to DB allows to store your messages to the database.
A LEARN MORE
29 Mana thath:
© Comments
Appearance Al (4) | Actve (1) | Inacive (3) | Recently Active (1) Search Installed Plugins
& Plugins BuiActons v | Apply tems
Installed Plugins
o g © Plugin Description
Edior O Akismet Used by millions, Akismet s quite possibly the bestuway in the world o protect your pam. It keeps your site pofecied flom spam even while you sieep. To get siarted: 1) Click the *Actvate* ink o the letof this descripton, 2) Sign up for an Akismet
Acivate | Edit|Delete | APIkey,and 3) Goto your AKismet configuratin page, and save your AP ky.
Users
8 Version 2559 | By Automattc | Visitplugin ste
T} Tools =
() Contact Form Pluginfor Conact Form,
Settings setings | Deactivate |01 | yergion 3,66 | By BestwebSot|Vistplugin it | Setings | FAQ | Support
2 BWS Plugins O Gallry i
e — Actate | Delete Version 4.0 | By BestWebSof| Viitplugin ste
(£ HelloDolly This i notjusta plugin, it symbolizes the hope e B rong: Hello,Dally. Wh ST T e S T T B D T AL e e T e G
Actvate | Edi| Delets
ivate | Edit] Delete Version 1.6 | By Matt Mullenweg | Vit plugin site
O Plugin Description
BukActons v | Apply tems
Thankyou for creating with WordPress. Version 371
9. Find “Gallery” and click “Activate”
. FIN allery” ana clic Ctivate'.
@ & | [ promo.bestwebsoft.com dmin/plugins.php b q, © =
e
Screen Options v/ | Help
(1 Dashboard .
(% Plugins  awnen
5 Posts
Media
= Contact Form to DB allows to store your messages to the database.
£ Pages LEARN MORE
g Manag thathave been sentflom
© Comments

Appearance Al ) | Actve (1) | nactive (3) | Recenty Actve (1 Search nstalled Plugins
& Plugins BukActons v [ Apply s
Instalied Plugins
1ot ) Plugin Description
AddNew
Edior O Akismet Used by millions, Akismet s quite possibly the bestuway in the world o protect your pam. It keeps your site pofecied flom spam even while you sieep. To get siarted: 1) Click the *Actvate* ink o the letof this descripton, 2) Sign up for an Akismet
Activate | Edit|Delete APl key, and 3) Go o your Akismet configuration page, and Save your AP ky.
Users
8 Version 2559 | By Automattc | Visitplugin ste
T} Tools =
() Contact Form Pluginfor Conact Form,
Setings | Deacivate | Edit
S ol ! Version 3.66 | By BestWebSoft| Visit plugin sie | Setings | FAQ | Support
3 BWS Plugins O Gallery i

Delet
= e Version 4.0.9 | By BestWeDSoft| Visit plugin site

[ HelloDolly ‘This is not justa plugin, it symbolizes the hope d up in two words sung byLc trong: Hello, Dolly. Wh
Activate | Edit| Delete

you will randomly see a lyrc from Hello, Dolly in the upper right of your admin screen on every page.
Version 1.6 | By Matt Mullenweg | Vit plugin site

[ Plugin Description
Bulk Actions v | Apply 4items
Thank you for creating with WordPress. Version 3.1
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Gallery Plugin

Installation Instruction

10.Voila - Gallery is activated!

€ R [ promobestuebsottcomvp i puns prptech s et s e _JBOE=
, :

e - Screen Optors v | el
(% Plugins s nen
5 Posts
Vedia
@ Contact Form to DB allows to store your messages to the database.
E Pages LEARN MORE
"ag Manag that h 1 sent from your we
® Comments
Galleries
e
Al (4) | Active (2) | Inactive (2) Search insialied Bluging|
& Plugins
pr—Po— Bucacions | Apply Stems
Add New [ Plugin Description
aior
O Axsmet Used by milons, Asmt s quite possiby e bestway I he word f protact your bog keeps your ste protecie fom spam even while you seep, To gt sarec: 1) Clckhe*Acivatnk o th ot tisdescrpton,2) Sgh up oran Adsmet
 Users Actvate | Edi | Delete APl ke, and 3) Go oyour Akismet canfiguraton page, and save your APIke.
T} Tools Version 2.5.9 | By Automatic | Visit plugin site
Settings O ContactForm Plugin for Contact Form.

Setings | Deacivate | Edit
e etings | Deactivate | Edityo\qion 3.66 | By BestWebSoft| Visit plugin site | Settings | FAQ| Support
O Gallery This plugin allows you to implement gallery page ino web site

FERET Setings | Deactvats
etings | Deaciivate Version 4.0.9 | By BestWebSoft| Visit plugin sie | Setiings | FAQ | Support

[J HelioDolly This is not justa plugin, hope d up in two words sung byLc Hello, Dolly. Wn you will randomly see a lyric-from Hello, Dolly in the upper right of your admin screen on every page.

Activate | Edit | Delet
ivate | Edit Delete Version 1.6 | By Mat Mullenweg | Visit plugin site

[ Plugin Description
BulkActions v | Apply 4items
Thank you for creating with WordPress. Version 3.1
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Gallery Plugin

Installation Instruction

4. Alternative way of installation

This way of installation is preferable when you download the plugin folder by using a download
link (mostly in case with Pro versions). In this case you do not have to extract the folder with the plugin
to your desktop, it will be extracted automatically in your dashboard.

1. Make sure there is the plugin’s zip-folder on your desktop.
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Gallery Plugin

Installation Instruction

2. Click “Plugins" in the menu on the left in your admin area.

+ New
Screen Options 7 | | Help
Dashboard
Home
Updates
Dismiss
s Posts Welcome to WordPress!
5 Media We've assembled some links to get you started:
) Pages Get Started Next Steps More Actions

@ Comments

s Wiite your first biog post [E] Manage widgets or menus
ustomize Your Site ~
Appearance [ Addan About page ®  Tum comments on or off
[Pragis]
&- or, change your theme completel & View your site Leam more about gefting started

4 Users
Tj Tools
Settings .

g Right Now QuickPress
Content Discussion
1 post T — =

Gy Add Media |
3 Pages 1 Approved 3
1 category 0 pending
0 Tags 0 spam )
Theme Twenty Thirteen with & Widgets
You are using WordPress 3.7.1. Save Draft | | Reset Publish
Recent Comments ER——
From Mr WordPress on Hello world! # There are no drafis at the moment

Hi, this Is a comment. To delete a comment, justlog in and view the posts comments. There you will have ...

‘WordPress Blog
Al | Pending (0) | Approved | Spam (0) | Trash (0)
WordPress 3.8 RC1 D 14,2013
‘We're entering the quiet but busy partof a release, whitling down issues to bring you all of the new features you're excited about with the stability you
‘expect from WordPress, There are just a few days ffom the “code freeze™ for our 3.8 release, which includes a number of exciting enhancements, so the
focus ]

Incoming Links

This dashboard widget queries Google Biog Search so that when another blog links to your site itwill show up here. It has found no incoming links.

SRS s WordPress 3.6 Beta 1 November 21
The first beta of the 3 8 is now available, and the next dates to waich outfor are code freeze on December 5th and a final release on December 12th. 3.8
brings together several of the features as plugins projects and while this isn't our firstrodeo, expect this to be more beta than usual. [..]

Plugins
Most Popular Other WordPress News
Capicha (nstall

Wordpress.tv: Scott Herman: Top 10 Plugins To Get You Started

This plugin allows you to Implement super security capicha form into web forms.
‘WrTavem: Poedit Adds Pro Support for WordPress Theme and Plugin Translation
Newest Plugins

Stream  (Install) WPTavem: A Look Back At WordPress Through The Years

3. Click “Add new" at the top of the page.

<t Dashboard Screen Options v | Help

% Plugins

All(2) | Inactive (2)
(gh Media
0 Pages Bulk Actions ¥ | Apply 2 tems

© Comments O Plugin Description
Used by millians, Akismet s quite possibly the best way in the world to pratect your blog from comment and trackback spam. It keeps your site protected from spam even while you sleep. To get started: 1) Click the *Activate” link to the left of this description, 2) Sign up for an Akismet API

s Posts
Search Installed Plugins

P Akismet
Activate | Edit] Delete  key, and 3) Go to your Akismet configuration page, and save your AP key.

(=]
& Plugins
Version 25.9 | By Automatic | Visit plugin site

Installed Plugins

1l [ HelioDolly This s not just a plugin, hope and enth f i d up in two words sung most famously by Louis Armstrong: Hello, Dolly. When activated you will randomly see a lyric from Hello, Dally in the upper right of your admin screen on every page.
Add New Activate | Edit] Delete

Version 1.6 | By Matt Mullenweg | Visit plugin site
Editor
8 Users O Plugin Description
T} Tools Bulk Actions v | Apply 2items
Settings
Version 37.1

Thank you for creating with WordPress,
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4. Click “Upload"”.

£} Dashboard %, .
% Install Plugins
s Posts
| Featured | Popular | Newest | Favorites
(g4 Media
D Pages Plugins extend and expand the ty of WordPress. You may install plugins from the Word Press Plugin Directory or upload a plugin in .zip format via this page.
Ci 1&
© comments soarcn
Appearance Search Plugins

& Plugins

Installed Plugins Popular tags

You may also browse based on the most popular ags in the Plugin Directory:

Add New
Editor . )
admin asx buddypress category comment COMMENLS content email Facebook feed gallery google image images javascrpt jquery

Users . - .

= ink iNk$ san mesia PAYE pages pnoto prows PIUGIN POSE POSIS 1ss seo shortcode SidEhar social sesm sms WIET viseo
Tools :

Widget wisgeis wordpress o
Settings.

Thank you for creating with WordPress.

5. Click “Choose file".

Screen Options v | Help

Version 37.1

4 Dashboard .
(% Install Plugins
s Posts
Search | Upload | Featured | Popular | Newest | Favorites
g Media
Pages
] Pag Install a plugin in zip format
® Comments lfyou have a piugin in a zip format, you may install it by uploading it here.

Appearance Choose File |[No file chosen

& Plugins

Installed Plugins
Add New
Editor

& Users
T} Tools
Settings

Thank you for creating with WordPress,
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6. A pop-up window will ask you to choose the file. Select gallery zip-folder and click “Open”.

Screen Options v | Help

& Dashboard .
% Install Plugins

P Posts
Search | Upload | Featured | Popular | Newest | Favorites

5y Media

Pages
) Pag Install a plugin in zip format
@ Comments Ifyou have a plugin in a zip format, you may install it by uploading it here.

[E5 Appearance ‘Choose File | No file chosen
& plugins

Installed Plugins

Add New

Egitor Places Name ~ Size | Modified
8 Users 2 Search 19 gallery-plugin.4.0.9.zip 695.1 KB 13:41
i outs ® Recently Used | |mm Screenshot.png 114.4KB 13:49

lag Screenshot-1.png 1763 KB 13:52

Settings Desktop Screenshot-2.png 88.9KB 1352
- I File System Screenshot-3.png 90.7KB 13:52
Screenshot-4.png 549KB 1353

TIOKYMEHTbI
B3 My3bika
KapTuHkm
Buaeo
3arpysku

o

Thank you for creating with WordPress. Version 37.1

7. Click “Install now".

Screen Options v | Help

4 Dashboard .
& Install Plugins

5 Posts
Search | Upload | Featured | Popular | Newest | Favarites

Media.

Pages
L) Pag Install a plugin in zip format
@ Comments Ifyou have a plugin in a zip format, you may install it by Uploading it here.

ppearance Choose Fill | gallery-plugin4.0.9.zip

& Plugins

Installed Plugins
Add New
Editor

& Users
Tj Tools

Settings

Thank you for creating with WordPress. Version 37.1
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Gallery Plugin

Installation Instruction

8. The resulting installation screen will list the installation as successful or note any problems
during the install.

b % Installing Plugin from uploaded file: gallery-plugin.4.0.9.zip
P Posts
Unpacking the package.
Medi:
5) Modia Installing the plugin
L] Pages Plugin installed successfully.

© Comments
Actvate Plugin

Retur to Plugins page
Appearance

& Plugins

Installed Plugins
Add New

Editor

8 Users

Tj Tools

Settings.
g

Version 37.1

Thank you for creating with WordPress.

9. Click “Activate plugin”.

Dashboard . . . . .
D= % Installing Plugin from uploaded file: gallery-plugin.4.0.9.zip
57 Post:

o Unpacking the package:

o
G Medta Installing the plugin
[C) Pages

Plugin installed successfully.
© Comments

[Actvale Plugin | Retum o Piugins page
Appearance

& Plugins

Installed Plugins
Add New
Editor

& Users
T} Tools
Settings

‘Thank you for creating with WardPress. Version 3.7.1
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Gallery Plugin

Installation Instruction

10.Voila - gallery is activated!

Screen Options v | Help

{1 Dashboard .
% Plugins  sanien
s Posts
Media o - i
El Its time to upgrade your Gallery plugin to PRO version!
0 Pages Learn More
"ag Extend standard plugin functionality with new great options.
© Comments
Galleries

Appearance
Al(3) | Active (1) | Inaciive (2) | Update Available (1) Sech stlled Dot
& Plugins
nstaled Plugin Bulk Actons v | Apply 3 tems
Add New (] Plugin Description
Editor
() Akismet Used by millions, Akismet is quite possibly the best way in the world o protect your blog from comment and trackhiack Spam. It keeps your stz protected ffom spam even while you sleep. To et sarted: 1) Click the “Actvate" link to the et of this description, 2) Sign up for an Akismet
4 Users Activale | Edit| Delete APl key, and 3) Go to your Akismet configuration page, and save your AP key.
T} Tools Version 259 | By Automatic | Vit plugin site
Settings Gallery This plugin allows you to implement gallery page into web site.

Setiings | Deactivate | Edit

9 BWS Plugins Version 4.0.9 | By BestWebSoft | Visit plugin site | Settings | FAQ | Support

There is a new version of Gallery available. View version 4.1.0 details or update now.
[ Helio Dolly This is notjusta plugin, it symbolizes the hope and enthusiasm of an entire generation summed up in two words sung most famously by Louis Amstrong: Hello, Dolly. When activated you will randomiy see a lyric from Hello, Dolly in the upper right of your admin screen on every page

Activate | Edit] Delete
== Version 1.6 | By Matt Mullenweg | Visitplugin site

(] Plugin Description
Bulk Actions v | Apply 3 items
‘Thank you for creating with WordPress. Version 371
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Gallery Plugin

Installation Instruction

5. How to use the plugin

1. Find the menu on your left.

f4 Dashboard
Dashboard
Home
Updates
P Posts. Welcome to WordPress!
3 odia We've assembled some links to get you started:
[Ele== Get Started Next Steps
© Comments
# Write your frst blog post
Galleries Customize Your Site
[ Add an About page
A

i) or, change your theme completely &) View yoursite
& Plugins
5, Users
T} Tools Right Now
= Content Discussion
) BWS Plugins 1 post 1 comment

2 pages 1 approved

1 category 0 pending

0 Tags 0 spam

‘Theme Twenty Thirteen with 6 Widgets

‘You are using WordPress 3.7.1.

Recent Comments

From Mr WordPress on Hello world! #
Hi, this is a comment. To delete a comment, ustlog in and view the posts comments. There you will have

All | Pending (0) | Approved | Spam (0) | Trash (0

Incoming Links

“This dashboard widget queries Google Blog Search so that when another blog finks to your ste it will show up here. Ithas found no incoming finks. .
Yet Its okay — there is no rush.

Plugins

2. Select “Galleries” => "Add a Gallery".

Screen Options v | | Help

Dismiss

More Actions

[ Manage widgets or menus

®  Tum comments on or off

& Leam more about getting started

QuickPress

Gy Add Media

Save Draft | | Reset

Recent Drafts

There are no drafts at the moment

WordPress Blog

WordPress 3.8 Beta 1 November 21, 2013
The first beta of the 3.8 is now available, and the next dates to waich out for are code freeze on December Sth and a final release on December 12th. 3.8
jeral of the I \d while this isn't our first r0de0, expectthis 1o be more beta than usual.[...]

‘WordPress 3.7.1 Maintenance Release Ociol
WordPress 3.7.1 is now available! This mainenance release addresses 11 bugs in WordPress 3.7, including: Images with captions no longer appear

broken n the visual editor. Allow p to check for updates from WordPress.org. Avoid fatal
ermors with certain plugins that were incorrectly calling som(...]

Othar WirdDrace Nowe

f4 Dashboard
Dashboard

Home

Updates

P Posts. Welcome to WordPress!

) Media We've assembled some links to get you started

[Ele== Get Started Next Steps

© Comments

# Write your first blog post

Galleries
Add an About page
T [ Add an About page
o, Change Vour Theme completely ] View you site
£ Plugins
& users
Tools
T Right Now
Settings
< Content Discussion
BB 1 post 1 comment
2 pages 1 approved
1 category 0 pending
0 Tags 0 spam
Theme Twenty Thirteen with 6 Widgets
You are using WordPress 3.7.1.
Recent Comments
From Mr WordPress on Hello worldi #
Hi,this s a comment. To delete a comment just log in and view the posts comments. There you will have
Al | Pending (0) | Approved | Spam (0) | Trash (0
Incoming Links
le Blog Search so thatwhen another blog links to your ste twil show up here. Ithas found o incoming links. -
yet Its okay — there is no rush.
Plugins
prom: admin/post- 7post_typ Y

Official website: http://bestwebsoft.com/
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Screen Options v | | Help

Dismiss

More Actions

[E  Manage widgets or menus
®  Tum comments on or off

& Leam more about getting started

QuickPress

Save Draft | | Reset

Publish

Recent Drafts

There are no drafts at the moment

‘WordPress Blog

WordPress 3.8 Beta 1 Nov
The first beta of the 3.8 is now available, and the next dates to watch out o are cade freeze on December Sth and a final release on December 121h. 3.8
jeral af the I \d while this isn't our first rodea, expect this to be more beta than usual.[...]

‘WordPress 3.7.1 Maintenance Release O
WordPress 3.7.1 is now available! This mainenance release addresses 11 bugs in WordPress 3.7, including: Images with captions no longer appear

broken n the visual editor. Allow p to check for updates from WordPress.org. Avoid fatal
ermors with certain plugins that were incorrectly calling som(...]
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Gallery Plugin

Installation Instruction

3. Enter a title for this gallery and click “Publish”.

() Dashboard

Add New Gallery

5 Posts

5 Media

{0 Pages Permalink: tp/promo bestwebsoft comi?post_type=gallery&p=23 | Change Permalinks

© Comments @ Add Media

B Galleries b

k || b-quote | et [ins [img | ui | ol || 1i | code | more | close tags | fullscreen

Galleries
Add a Gallery

Appearance
£ Plugins

& Users

T} Tools
Setiings

3 BWS Plugins

Word count: 0

Upload File
Choose an image for upload:
‘The gallery temp directory (gallery-pluginiuploadiles) is not available for record on your webserver. Please use the standard W functionality to upload images (media library)

CJ Allow the download link for all images in this gallery

php)

Please use the drag and drop function to change an order of the images displaying and do not forgetto save the post
Please make a choice "Sort images by’ -> sortimages’ on the pi ti (hitp:Zpromo bestwebsof.

Discussion

) Allow commens.
) Allow rackbacks and pingbacks on this page,

Author

4. Click “Add media” button to upload images.

sual | | Text

Draft saved at 10:15:05 am.

Screen Options

Gallery Shortcode
You can add a Single Gallery to the page or
postby inserting this shortcode into the
content:

[print_gllr id=23]
I you wantto display a short description
‘containing a screenshot and the link to the
Single Gallery Page:

[print_gllr id=23 display=short]

Publish
Save Draft Preview

Status: Draft Edit

Visibilty: Public Edit

[§i] Publish immediately Edit
Move to Trash Publish

Attributes
Order

0

Featured Image

Setfeatured image

{3} Dashboard

Edit Gallery 4ddacatery
5 Posts

g, Media Post published. View post
[C] Pages

© Comments Gallery 1

Permalink: hitp:/promo bestwebsoft.comr2galiery=gallery-1-2 | Change Permalinks | View Gallery [ Get Shortink

Galleries
Add a Gallery

o | i |[tink [ b-quote | eet] ins | img | u | o | i | code| more | close ags [ screen
[ Appearance

£ Plugins

&, Users

T} Tools

(i Settings

3 BWS Plugins

Word count: 0

Upload File

Choose an image for upload:
The gallery temp directory (gallery-pluginiuploadiiiles) is not available for record on your webserver. Please use the standard WP functionality to upload images (media library)
) Allow the download link for all images in this galle

Please use the drag and drop function to change an order of the images displaying and do not forget o save the post
Please make a choice "Sort images by -> sortimages’ on the pl t (hitpJ/promo.bestwebsof. php)

Discussion

) Allow comments.
) Allow trackbacks and pingbacks on this page.

Official website: http://bestwebsoft.com/
Support forum: http://support.bestwebsoft.com/

Visual || Text

Last edited by root on December 3, 2013 at 2:29 pm

Screen Options

Gallery Shortcode
You can add a Single Gallery to the page or
postby inserting this shortcode into the
content:

[print_gllr id=33]

Ifyou wantto display a short description
containing a screenshot and the link to the
single Gallery Page:

{print_gllr 1d=33 display=short]

Publish

Preview Changes
Status: Publshed Edit
Visiblty: Public Egit

2] Publshed on: Dec 3, 2013 @ 14:20 Edit

Move to Trash Upa:

Attributes
Order

0

Featured Image

Setfeatured image
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Gallery Plugin

Installation Instruction

5. Click “Select files” button to select images.

[ promo.bestwebsoft.com/wp-admin/post

Insert Media Insert Media

Create Gallery Upload Files  Media Library

Set Featured Image
All media tems v

Insert from URL

No items found.

Drop files anywhere to upload

Select Files

Maximum upload fle size: 2MB.

6. Click “Open” to start uploading.

€« £ | [ promo.bestwebsoft.com/wp-admin/post.php

T——— HRpom =

Insert Media Insert Media

Create Gallery Upload Files  Media Library

Set Featured Image
All media tems v

&)

(3
Insert from URL —

3] [Jam)
Places. Name ~ | size | Modified]|d unsplash_5281fc5adc3ad_1.JPG
4 Search
@ Recently Used | jami
lag
© Desktop
I File system

Concel
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Gallery Plugin

Installation Instruction

7. After uploading is completed, you will see the images.

[} promo.bestwebsoft.com,

Insert Media Insert Media

Create Gallery Upload Files  Media Library

Set Featured Image
All media tems v

Insert from URL —

Dashboard - Screen Options
& Edit Gallery 4ddacatery
 Posts
g Mot Post updated. View post
Pages

Gallery Shortcode

@ comments Gallery 1 @ y
) cai Permalink: hpipromo.bestwebsoftcom/2gallery-gallery-1-3 | Change Permalinks | View Gallery || Get Shortink You can add a Single Gallery 0 the page o

2 post by inserting this shortcode into the.
Galleries: ) Add Media | e content
Add a Gallery —

! b | i | link b-quote @et|ins img ul | o | Ii | code| more  close tags  fullscreen [print_gllr id-40]

{5 Appearance If you wantto display a short description
o containing a screenshot and the link to the
£ Plugins Single Gallery Page:
& users [print_gllr id=40 display=short]
'” Tools L
Settings Publish
3 BWS Plugins Preview Changes

Status: Published Edit
Visiilty: Public Edt

8] Published on: Dec 4, 2013 @ 7:42 Edit

Move to Trash
Auibutes

Word count:0 Lastedited by rooton December 4,2013 at7:42 am
Order

Upload File

L 0
Choose an image for uploac .
The gallry temp diectory (gallery-pluginiuploadiles) is ot avaiable forrecord on you webserver. Please use the standard WP functonalfy o upload images (media brary) Featured Image

Allow the download link for all mages in this gallery

‘Setfeatured image

Please use the drag and drop function to change an order of the images displaying and do not forgetto save the post Setfeatured image
bsoftcom

Please make a choice "Sortimages by’ -> sortimages’ on the plugin setiings page ( hitp/promo.besty php)

Discussion

@) Allow comments.
¥} Allow rackbacks and pingbacks on this page.

(T
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Gallery Plugin

Installation Instruction

9. The images will appear in the meta box.

Move 10 Trash

Adtributes
Word count: 0 Last edited by root on December 3, 2013 ai 2:40 pm
Order
Upload File
0
Choose an image for upload:
The gallery temp directory (gallery-plugin/uploadfiles) is not available or record on your webserver. Please use the siandard WP funcionality fo upload images (media library) e

J Allow the download link for all images in this gallery

‘Setfeatured image
Please use the drag and drop function to change an order of the images displaying and do not forget to save the post. Setfeatured image

Please make a choice "Sort images by’ -> sortimages’ on the pl Jipromo bestwebsot. php)

o

Tite Tite
Alttag Alttag |
URL URL

oy clck on image opens aink in a new window) (by cick on image

Open the link Open the link
Current window Currentwindow
New window New window

Delete Delete

Discussion

) Allow comments.
) Allow rackbacks and pingbacks on this page. | |

Comments

Add comment

(T

No comments yet

10.To add your gallery to a page, click “Pages” => “Add New" and enter the title for this page.

() Dashboard Screen Optons v | | Help

Add New Page
# posts

g, Media Gallery page @ | Publish

i Pages Permalink: htp:/ipromo bestwebsoft com/?page_id=27 | Change Permalinks Save Draft Preview

AllPages ) Add Media Visual|[Text Status: Draft Egit
Add New
b | i | k] b-quote et [ins]/img [ ur | of | 1 | code | more | close tags | uiiscreen Visiilty: Public Edi

@ Comments
i) Publish immediately Edit

Galleries
Move to Trash Publish

Appearance

£ Plugins

4 Users Page Atributes

T} Tools Parent

Settings (oparenty v
Template

3 BWS Plugins

Default Template v
Order
0

Need help? Use the Help tab in the upper right

Word count 0 Draft saved at 10:23:48 am of your screen.
Featured Image
Setfeatured image

Thank you for creating with WordPress. Version 3.7.1
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Gallery Plugin

Installation Instruction

11.Find select box with the name “Template” under the Publish button, select “Gallery
Template” and click “Publish”.

(3 Dashboard Screen Options | | Help
Add New Page
2 Posts
) Media Gallery page Publish
Permalink: hp:ipromo bestwebsoft comi?page._id=27 | Change Permainks Save Draft Preview
All Pages (B Add Media e Status: Dratft Edit
AdaNow
b | 1 | ik b-quot | et ns[img | ut | of | 1 | code | mor | ciose ags  ascreen Vit Public it
© Comments
£ Publish immediatel Eqi
Galleries
_ =
Appearance Ll
£ Plugins
% Users. Page Attributes
T} Tools parent
Settings (opareny v
3 Bws Plugins Tompite
Gallry Tempiate v
orer
0
Need help? Use the Help b n the upperight
Word count: 0 Draftsaved at 102348 am of your screen.

“Thank you for creating with WordPress.

12.Click “View" to view the gallery on your page.

Featured Image

Setfeatured image

Version 3.7.1

e ) Screen Opions 7| | Help
Edit Page Addnew
 Posts
g Metia Page published|
Pages

Publish
Allpages Gallery page
Add New Permalink: htp:/ipromo bestwebsoft com/?page_id=27 | Change Permalinks || View Page Preview Changes
© Comments @ Add Nedia Vel (o Sius: Published i
Galleries b | i |tink] b-quote | et [ins img| ul | of | i | code | more | close tags | iscreen Visibiliy: Public Edit
Appearance 3 Published on: Dec 3,2013 @ 10:25 Edit
£ Plugins

Move to Trash
& Users
T} Tools

Page Attributes
Setiings ¢

Parent
) BWS Plugins

(noparen) v

Template

Gallery Template v

Order

o

Need help? Use the Help tab n the upper right

Word count: 0 Lastedited by root on December 3, 2013 at 10:25 am ofyour screen.

Thank you for creating with WordPress.
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Support forum: http://support.bestwebsoft.com/

Featured Image

Setfeatured image
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Gallery Plugin

Installation Instruction

13.You will see your gallery on this page.
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14.Click “See images” to view the images.
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Gallery Plugin

Installation Instruction

15.You will see the images.
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Gallery Plugin

Installation Instruction

17.You can adjust the necessary settings using your WordPress admin panel in “Plugins” =>
“Installed plugins”’ => “Gallery”

plugin_status=all&paged=1&s=

prom om @ -+ New

(5 Dashboard

;\’@ Plugins  Aganew

 Posts
) Media
Contact Form to DB allows to store your messages to the database. LEARN MORE

= Mana been sentfiom your b,
© Comments
[# Galleries Plugin activated
Appearance

AN(4) | Acive (2) | Inaciive (2) Seard oskled Bunin)
& Plugins
Installed Plugins BulkcActons || Apply 4 ttems
Add New ] Plugin Description
Edior

[ Akismet Used by millons, Akismet s quite possibly the bestway in the world t protect your blog Itkeeps your ste protected rom sp you sleep. To getstarted: 1) Click the "Activate” link o the letof this description, 2) Sign up for an Akismet
4 Users Activate | Edit| Delete APl key, and 3) Go to your Akismet configuration page, and save your AP key.
T} Tools. Version 259 | By Automatic | Vit plugin site
Settings [ ContactForm Plugin for Contact Form.

Setings | Deactvale | Edtyercion 3,66 | By BestWebSot | Visiplugin site | Setings | FAQ | Support

[ calle “This plugin allows you to implement gallery page inio web site.
s L 1By Bestebsot | Vis pginste | Setings | FAQ| Support

3 BWS Plugins

[J HelloDolly This is not justa plugin, h d up in two words sung byL Hello, Dolly. Wn you will random Iyric from Hello, Dolly in the upper right of your admin screen on every page.

Activate | Edit | Delet
ivate | Edit Delete Version 1.6 | By Mat Mullenweg | Visit plugin site

[ Plugin Description
Bulk Actions v | Apply 4items
Thank you for creating with WordPress. Version 3.1

This instruction can be applied mostly to Gallery Pro, too.

Thank you!

Want to hire a programmer or designer? Read the information below.

Our team provide custom design and programming services. Make sure you attach a detailed
description of your requirements to get a quote from our specialists.

Feel free to submit your request via contact form on our official website:

http://bestwebsoft.com/contacts/contact-us/
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